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EXECUTIVE SUMMARY 

Conventional culverts are mainly designed to transport water underneath roadways with minimal 

headwater buildup, resulting in low to moderate peak flow attenuation. On-road structures (ORS) 

offer an alternative by using the roadway embankment as a dam, restricting flow into the culvert 

to provide flood storage during large precipitation events.  

In this project, statewide geographic information system (GIS) analyses were conducted that 

identified approximately 250,000 potential ORS locations with a combined storage capacity of 2 

million acre-feet and a pool area covering 900,000 acres, representing about 2.7% of Iowa. A 

methodology was developed to automate the hydrologic design of individual ORS, enhancing the 

identification of those that offer significant peak flow reduction benefits. In addition, the peak 

flow reduction benefits were quantified at the HUC12 watershed scale for ORS systems. For a 

50-year storm event, peak flows at watershed outlets were reduced by approximately 18%. 

The research outcomes are accessible through a web portal named the Iowa Department of 

Transportation (DOT) On-Road Structures (IDOT-ORS) information platform. This platform 

facilitates the dissemination of results, allowing various stakeholders to view information on 

ORS locations, expected pool and drainage areas, structure designs, and inflow and outflow 

hydrographs for several return periods. The platform can be accessed at 

https://hydroinformatics.uiowa.edu/lab/idot-ors/.  

 

https://hydroinformatics.uiowa.edu/lab/idot-ors/
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1. PROBLEM STATEMENT AND OBJECTIVES 

One of the main objectives of traditional culvert design is to allow flood waves to pass from one 

side of the road to the other with relatively low headwater elevation, leading to low to moderate 

peak flow attenuation (Schall 2012). During heavy precipitation events, flows passing quickly 

through upstream culverts are more likely to combine and potentially overwhelm downstream 

culverts; damage bridges, roads, and infrastructure; and impact downstream communities and 

farms. 

On-road structures (ORS) present a viable alternative to traditional culvert design and have the 

potential to mitigate flood impacts. ORS utilize the roadway embankment as a dam, restricting 

flow into the culvert to provide flood storage for significant peak flow events (e.g., up to the 50- 

or 100-year return period). Figure 1 presents examples of ORS built in Northeast Iowa. Several 

counties in Iowa have implemented ORS in HUC12 watersheds, and anecdotal evidence suggests 

that these structures have reduced the flood impacts of recent extreme rainfall events. However, 

Iowa lacks a detailed statewide geospatial database identifying which existing culverts are 

suitable candidates for conversion to ORS. Additionally, a HUC12-scale assessment of the 

potential for peak flow reductions of a system of ORS has not yet been conducted. 

 

Figure 1. Examples of on-road structures located in Northeast Iowa 

This project addressed these knowledge gaps by integrating geographic information system 

(GIS) and hydrologic analysis, rainfall runoff modeling, and hydroinformatics. Specifically, the 

objectives of this project were as follows: 

1. Construct a statewide geospatial database identifying suitable locations for the construction 

of ORS, including information on flood storage, expected pool areas, and drainage areas. 

2. Develop a methodology to programmatically complete planning designs for the individual 

ORS identified in Objective 1. These designs will allow for the estimation of structure-level 

peak flow reductions under different design storm scenarios. This work was completed in six 

selected HUC12 watersheds. 
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3. Assess the HUC12-scale flood reduction benefits of a system of ORS. To achieve this, the 

research team used the process-based hydrologic model Generic Hydrologic Overland-

Subsurface Toolkit (GHOST) described in Politano et al. (2023). This work was also 

completed in six selected HUC12 watersheds. 

4. Leverage the research team’s expertise in hydroinformatics to develop a web platform to 

communicate the results of Objectives 1 through 3. 

In this project, the research team worked closely with the Iowa Department of Transportation 

(DOT) and the project’s technical advisory committee (TAC) to select the HUC12 watersheds 

for the hydrologic simulations, find ways to best communicate the results of the hydrologic and 

statewide GIS-based analyses, and design the proposed website to disseminate the project’s 

results. 
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2. BACKGROUND INFORMATION 

This chapter outlines the magnitude and severity of the flooding problem in Iowa, provides 

examples of existing ORS, and discusses the application of hydrologic modeling to evaluate 

flood mitigation strategies. Additionally, it highlights the use of web-based information systems 

in Iowa to support these efforts. 

2.1. Flooding in Iowa 

Flooding is one of the most pressing challenges facing Iowa. Records maintained by the Federal 

Emergency Management Agency (FEMA) indicate that out of the approximately 1,300 federally 

declared disasters in Iowa counties from 1989 to 2022, approximately 80% were related to 

flooding (Figure 2).  

 
Raw data from https://www.fema.gov/  

Figure 2. Flood-related disaster declarations in Iowa counties (1989–2022) 

Iowa’s estimated losses from flooding are substantial. The SHELDUS database (1988–2015) 

reports $13.5 billion in direct property losses and $4.1 billion in direct crop losses 

(https://cemhs.asu.edu/SHELDUS/). In 2019 alone, the National Oceanic and Atmospheric 

https://www.fema.gov/
https://cemhs.asu.edu/SHELDUS/
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Administration (NOAA) estimates that extreme weather generated losses of approximately $1.9 

billion in Iowa, with flooding being the main driver of these losses. Improving Iowa’s resilience 

to flooding will require significant investment, creative thinking, and innovation. ORS are an 

example of how infrastructure repair or replacement investments can be used to lessen the future 

impacts of flooding. By temporarily retaining water runoff from high-intensity precipitation 

events, ORS can reduce damage to county roads, bridges, and culverts and protect downstream 

communities and farmland. 

2.2. Examples of On-Road Structures in Iowa 

The North Bear Creek HUC12 watershed spans Allamakee and Winneshiek Counties in Iowa, as 

well as Fillmore and Houston Counties in Minnesota. This watershed has pioneered the 

installation of ORS in both Iowa and Minnesota, with stakeholders identifying 56 locations 

suitable for constructing these structures (Figure 3). 

 

Figure 3. ORS in North Bear Creek 

The U.S. Department of Housing and Urban Development funded the Iowa Flood Center (IFC) 

to lead the Iowa Watersheds Project (IWP) (Weber et al. 2018). The IWP focused on selected 

Iowa watersheds, developing comprehensive watershed plans, and collaborating with local 

volunteers to design and build water management projects. In its second phase, the IWP 

supported the construction of five ORS, along with several ponds and water and sediment control 

basins (WASCOBs) in the Otter Creek HUC12 watershed in Fayette County (Figure 4). 

Analyses presented by the IFC (2016) demonstrated that ORS were the most effective option for 
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reducing peak discharges, providing an estimated 30% peak flow reduction for 50-year 

recurrence flows in some tributaries.  

 

Figure 4. IWP Phase II project locations in the Otter Creek Watershed 

More recently, the Iowa Watershed Approach project, funded through the National Disaster 

Resilience Competition, has also sponsored the construction of ORS in Iowa 

(https://iowawatershedapproach.org/). 

2.3. Distributed Storage and Hydrologic Modeling 

Several studies have demonstrated the efficacy of distributed storage systems in mitigating flood 

impacts (Thomas et al. 2016, Ayalew et al. 2017). While the flood reduction benefit from a 

single detention structure may not be significant at the watershed scale (e.g., at the outlet of a 

HUC12), the combined effect of multiple structures can be substantial. In recent years, three 

projects in Iowa have extensively evaluated hypothetical and constructed detention structures 

(mostly off-road structures) located in watershed headwater catchments: the Iowa Watersheds 

Project (Weber et al. 2018), the Iowa Watershed Approach 

(https://iowawatershedapproach.org/), and the Des Moines River Upstream Mitigation Study 

(Arenas et al. 2020). 

https://iowawatershedapproach.org/
https://iowawatershedapproach.org/
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2.4. Web-Based Information Systems 

The following are examples of user-friendly, interactive, web-based information systems 

designed to communicate environmental and geospatial information in Iowa and the United 

States (Xu et al. 2019, Demir and Krajewski 2013, Demir et al. 2018): 

• The Iowa DOT Culvert Platform provides information on culverts throughout the state of 

Iowa. https://apps.iowadot.gov/culverts/. 

• The Iowa Flood Information System is a comprehensive web-platform to access community-

based flood conditions, forecasts, visualizations, inundation maps, and flood-related 

information. http://ifis.iowafloodcenter.org/ifis/. 

• The Iowa Water Quality Information System integrates real-time water-quality data collected 

by IIHR–Hydroscience & Engineering and the U.S. Geological Survey, along with a variety 

of watershed-related information such as precipitation, stream flow and stage, soil moisture, 

and land use. https://iwqis.iowawis.org/.  

https://apps.iowadot.gov/culverts/
http://ifis.iowafloodcenter.org/ifis/
https://iwqis.iowawis.org/


7 

3. METHODOLOGY 

The objectives of this project were accomplished following the methodology described below. 

3.1. Statewide GIS Analyses 

The statewide GIS analyses were developed using 2-meter digital elevation models (DEMs) for 

all of the HUC12 watersheds in Iowa. For each watershed, the DEMs were modified to ensure 

that the elevation datasets accurately reflected how water moves across the landscape by 

following a hydroenforcement or hydroconditioning process. Special attention was given to the 

intersections of roadways and waterways, where cuts were added to the DEMs at crossings as 

needed. Following this, flow paths starting at a drainage area accumulation of 10 acres were 

generated, as presented in Figure 5.  

 

Figure 5. DEM before hydroenforcement (left), cuts (culverts) added and flow paths 

generated (middle), and storage pools estimated assuming ORS elevations of 50%, 70%, 

and 90% of the road height (right) 

Eight steps were followed to calculate storage volumes behind ORS: 

1. Create intersection points. Use the flow path and intersect it with the road coverage 

(Analysis Tools > Overlay > Intersect) to create intersection points. 

2. Buffer and clip road coverage. For each point in the intersection coverage, create a 10-

meter buffer (Analysis Tools > Proximity > Buffer). Clip the road coverage with the buffer 

(Analysis Tools > Extract > Clip). 

3. Obtain road elevation. Run Zonal Statistics (Spatial Analyst Tools > Zonal > Zonal 

Statistics as Table) on the clipped road segment to obtain the elevation of the road. Use the 

median value as the road elevation and the minimum value as the base elevation. Calculate 

the road height as the median elevation minus the minimum elevation. Calculate the height of 

the overflow structure as a percentage (50%, 70%, or 90%, as shown in Figure 5) of the road 

height, with 50% as the default. Make the percentage variable so it can be adjusted as 

needed. 

4. Snap intersection point. Snap the intersection point (Spatial Analyst Tools > Hydrology > 

Snap Pour Point) to the Flow Accumulation grid using a 2-meter tolerance. 
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5. Create watershed. Use the snapped intersection point to create the watershed for the point 

(Spatial Analyst Tools > Hydrology > Watershed). 

6. Convert watershed grid to polygon. Convert the watershed grid to a polygon with “no 

simplify” (Conversion Tools > From Raster > Raster to Polygon). Calculate the area of the 

polygon in acres. 

7. Create storage pool area grid. Use the overflow structure height to reclassify the DEM and 

create a grid of the storage pool area (Spatial Analyst Tools > Reclass > Reclassify). Use two 

values: the structure height for the first value and NoData for everything higher. Set the 

extent and mask values to the watershed polygon to limit the reclassification to that area. 

8. Calculate depth and volume of storage pool. Use Raster Calculator to subtract the DEM 

from the pool elevation grid, creating a grid of the storage pool depth. Calculate the volume 

of each pool elevation value using the following formula: Ac_ft = ((Count * 4) / 4046.856) * 

(([Value] * 3.2808) / 100). Run Statistics on Ac_ft to sum the values and calculate the total 

storage volume of the pool. Convert the storage pool grid to a polygon, add the storage 

volume to the polygon, and append the polygon to the HUC12 coverage of the storage pools. 

The process described above was completed using Esri software and the Agricultural 

Conservation Planning Framework preparation tools (https://acpf4watersheds.org/). 

3.2. Planning Designs 

To complete the planning designs, the ORS were conceptualized as a system comprising a 

horizontal pipe at the bottom (D1), a vertically positioned orifice (D2), and a riser pipe (D3) that 

can be adjusted to different elevations. Figure 6 provides a schematic representation of this 

system. These outlets operate in stages, activating progressively as water levels increase, which 

ensures efficient water management during varying storm intensities. The design and analysis of 

these ORS were automated using Python scripts in ArcGIS, enabling the programmatic design of 

many ORS. The text below describes the implementation and functionality of these scripts. 

 

Figure 6. Typical ORS, showing the three outlets (D1, D2, and D3), their activation levels, 

and the different storms considered during the iterative design process 

https://acpf4watersheds.org/
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The structure presented in Figure 6 operates with varying activation levels as the water surface 

rises in response to different design storms. The first outlet (D1) handles the less severe design 

storms. As storm intensity increases, the second outlet (D2) is activated to manage higher runoff 

levels. Finally, the third outlet (D3) comes into play during the highest storm intensities to 

manage maximum runoff. This tiered response ensures effective water management and flood 

control for the on-road structures. 

A systematic approach was adopted using three Python scripts within ArcGIS to automate the 

design and analysis process of the ORS. These scripts operated in stages, starting with initial data 

derived from the statewide GIS analyses described above.  

3.2.1. Script 1 

In the first stage, hydrological analysis was performed to generate files with hydrological 

information. The inputs were DEMs, ORS locations, and soil and land use information. The 

script performed the flow length generation using Flow Length (a module within the ArcGIS 

Spatial Analyst toolbox) and the Curve Number (CN) method (USACE 2022). For each area that 

drains to the ORS, the script computed the composite CN by analyzing gridded data on soil type 

and land cover. The input and output data are displayed in Table 1. 

Table 1. Script 1. Input and output data 

 File Type 

Input Data 

DEM Raster file 

On-road structures (ORS) Point shapefile 

Drainage areas (DA) Polygon shapefile 

Land use Raster file 

Soil type Raster file 

Table CN versus landcover Table 

Output Data 

DEM fill Raster file 

Flow direction Raster file 

Flow length Raster file 

DA with CN composite values Polygon shapefile 

 

3.2.2. Script 2 

The second script focused on hydrologic modeling using the rational method (Chow et al. 1988) 

and the CN model. The script followed these steps: 

1. Hydrological Values Computation. Hydrological parameters relevant to the design of ORS 

were computed. These values included time of concentration, precipitation excess, rainfall 

intensity, and runoff coefficients for each watershed.  
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2. Peak Discharge Calculation (Q). The rational method (Chow et al. 1988) was applied to 

calculate each watershed’s peak discharge (Q). This calculation was performed for multiple 

return periods for different storm events. 

 The input and output data are displayed in Table 2. 

Table 2. Script 2. Input and output data 

 File Type 

Input Data 

DEM Raster file 

DA Polygon shapefile 

Flow length Raster file 

Pool area (50%, 70% or 90%) Polygon shapefile 

Precipitation raster files (1, 2, 5, 

10, 25, 50, 100, 200, 500 YR) 
Raster file 

Output Data 

DA Polygon shapefile 

Table DA 

Table with the following values: Q 

(1, 2, 5, 10, 25, 50, 100, 200, 500 

YR), delta elevation, length, road 

elevation, time of concentration 

 

3.2.3. Script 3 

The final stage involved determining D1, D2, and D3 (Figure 6). The script executed the 

following processes: 

1. Inflow hydrograph. Using the data generated in the previous steps and applying the unit 

hydrograph methodology (USDA NRCS 2007), along with the SCS Type II Rainfall 

Distribution, the inflow hydrograph to the ORS was generated. 

2. Iterative outlet sizing. The script was developed to perform the following iterative design 

process: 

• The bottom outlet (D1) is the initial discharge point, handling the initial runoff. The 

design process involved iterative testing of pipe diameters ranging from 4 to 24 inches 

and return periods of 1, 2, 5, and 10 years. The process involved finding the appropriate 

diameter and return period for which the water surface elevation did not activate the 

second outlet (D2). The criterion for this first outlet (D1) was that it should not exceed 

30% of the road elevation. Once this step was completed, D1 was fixed, allowing the 

dimensioning of the remaining two outlets. 

• The second outlet (D2). The horizontal pipe (D1) and the orifice (D2) work together 

when the water level rises to a moderate level, effectively managing increased runoff 

during more intense storms. The design process for D2 involved iterative testing of pipe 

diameters ranging from 4 to 24 inches and return periods of 2, 5, 10, 25, 50, and 100 

years. The process involved finding the appropriate diameter and return period for which 

the water surface elevation did not activate the third outlet (D3). The criterion for D2 was 
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that it should not exceed 30% of the road elevation. Once this step was completed, D2 

was fixed. 

• The third outlet is the riser pipe (D3), which can be at 50%, 70%, or 90% of the road 

height, depending on the evaluated pool. This outlet engages during significant storms, 

allowing the structure to manage maximum flows without overtopping the road. The 

design process involved iterative testing of pipe diameters ranging from 24 to 72 inches 

and return periods of 25, 50, 100, 200, and 500 years. The process involved finding the 

diameter and return period for which the water levels were below 90% of the road height.  

• As a result of the design, the outflow hydrograph was obtained for multiple return 

periods, which allowed for the quantification of the peak flow reductions associated with 

each of the ORS. Once D1, D2, and D3 were found, stage-storage-discharge curves for 

each ORS were generated. 

The input and output data are displayed in Table 3. 

Table 3. Script 3. Input and output data 

 File Type 

Input 

Data 

DEM Raster file 

DA with an attribute table 

containing design values 
Polygon shapefile 

Unit hydrograph NRCS Table 

Rainfall distribution (SCS Type II) Table 

Output 

Data 

Stage, storage, and discharge Curves and tables 

Inlet and outlet hydrographs (D1, 

D2 and D3 outlets) 
Curves and tables 

 

3.3. HUC12-Scale Hydrologic Modeling 

For the six selected HUC12 watersheds depicted in Figure 7, the GHOST model was utilized to 

evaluate the flood reduction benefits of ORS at the watershed scale. GHOST is a rainfall runoff 

model extensively validated across various watersheds in Iowa. It is designed for both event-

based and multi-year simulations in small catchments and large basins, employing finite volume 

techniques. Within GHOST, surface flows are simulated using a 2D diffusive wave 

approximation of the Saint Venant equations, while water depth in canals and streams is 

computed using a 1D approach. The model also simulates unsaturated zone dynamics under a 

vertical dominant flow assumption, and groundwater flow is governed by Darcy’s law. Processes 

such as infiltration, exfiltration, recharge, and lateral mass exchanges between surface and 

groundwater domains are accounted for in the flux calculations. Figure 8 highlights the key 

hydrologic processes incorporated within the GHOST model.  
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Figure 7. Selected HUC12 watersheds for the generation of planning designs for the ORS 

(Objective 2) and watershed modeling (Objective 3) 

 

Figure 8. Hydrologic processes, domains, and fluxes modeled in GHOST 

The predictive capabilities of GHOST have been extensively validated across various watersheds 

in Iowa, encompassing diverse soil types, topographies, land covers, geological histories, and 
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hydrologic conditions. For this project, existing GHOST models that were previously calibrated 

were leveraged, obviating the need for additional model calibration or parameter estimation. 

Further details on the GHOST model and its performance across Iowa watersheds can be found 

in Arenas et al. (2020), Weber et al. (2023a), Weber et al. (2023b), Young et al. (2023), and 

Politano et al. (2023). 

In the study of the six selected HUC12 watersheds (Figure 7), the research team assessed the 

hydrologic model’s ability to predict peak flows by comparing modeled outputs against data 

from StreamStats (Ries III et al. 2017). The comparison revealed that the best agreement 

between peak flows predicted by GHOST and StreamStats occurred at the 50-year return period, 

which was consequently chosen for the analyses. 

3.4. Web Platform 

In this project, cyberinfrastructure concepts were used to develop the Iowa DOT On-Road 

Structures (IDOT-ORS) information platform, available through this URL: 

https://hydroinformatics.uiowa.edu/lab/idot-ors/. 

This platform facilitates access to the locations and the pool and drainage areas of existing and 

potential on-road structures in Iowa. In addition, in selected HUC12 watersheds (Figure 7), the 

results of the planning designs are displayed.  

The core functionalities and capabilities of the system include the following: 

1. Web-based cyberinfrastructure designed for information sharing and communication 

regarding on-road structures. The system features advanced visualization and filtering tools 

supported by a relational database housing data and model outputs from the data analytics 

subsystem. 

2. Data analytics components for modeling and analysis. These components evaluate the flood 

reduction benefits of existing and potential on-road structures and estimate the flood storage 

potential from ORS. 

The web platform enables users to visualize project results across various spatial scales. For 

watersheds without planning designs, users can view the locations of viable ORS identified 

through statewide GIS analyses, along with corresponding pool polygons, drainage areas, and 

flow paths. Additionally, aggregated total storage can be visualized at the HUC12 scale, as 

depicted in Figure 9. Moreover, for HUC12 watersheds with planning designs, users can access 

final design results, including values of D1, D2, and D3 (referenced in Figure 6), as well as 

hydrographs showing inflows and outflows for multiple return periods. 

https://hydroinformatics.uiowa.edu/lab/idot-ors/
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https://hydroinformatics.uiowa.edu/lab/idot-ors/ 

Figure 9. IDOT-ORS information platform, showing aggregated flood storage at the 

HUC12 level 

The platform serves as a pivotal integration point among the project components, facilitating the 

communication of data and modeling outcomes. Recent initiatives among the research 

community underscore the importance of deploying information and communication 

technologies to advance environmental and geoscience research. Data within the natural sciences 

are frequently high dimensional, posing challenges in comprehending and extracting meaningful 

patterns. One effective strategy to enhance comprehension involves providing visual insights into 

analyzed datasets. Data and information visualization offers graphical, often interactive 

representations of multidimensional datasets, empowering users to grasp and extract information 

for further investigation. The IDOT-ORS platform enables users to explore and evaluate analysis 

results through an interactive user interface. It provides accessible information on the flood 

reduction benefits of existing on-road structures and estimates the flood storage potential from 

new ORS in a user-friendly and intuitive environment. 

  

https://hydroinformatics.uiowa.edu/lab/idot-ors/


15 

4. RESULTS 

4.1. Statewide GIS Analyses 

The statewide analyses identified approximately 250,000 ORS with a combined storage capacity 

of 2 million acre-feet and a pool area covering 900,000 acres, which accounts for about 2.7% of 

the state of Iowa. Interesting patterns emerge when the results are aggregated at the HUC12, 

HUC8, and county levels, as shown in Figures 10, 11, and 12. The HUC12 watersheds with the 

highest storage volumes are predominantly located in North Central Iowa and certain areas of the 

Missouri and Mississippi River floodplains. However, these areas also exhibit relatively high 

pool area values, which might generate resistance to ORS implementation among landowners 

due to the larger areas inundated during heavy precipitation events. The maximum number of 

ORS found at the HUC12 , HUC8, and county levels was 364, 12,513, and 4,216, respectively.  

 

Figure 10. Statewide GIS analyses aggregated at the HUC12 level: number of ORS, flood 

storage (acre-feet), pool areas for the 70% ORS (acres), and drainage areas (acres) 



16 

 

Figure 11. Statewide GIS analyses aggregated at the HUC8 level: number of ORS, flood 

storage (acre-feet), pool areas for the 70% ORS (acres), and drainage areas (acres) 

 

Figure 12. Statewide GIS analyses aggregated at the county level: number of ORS, flood 

storage (acre-feet), pool areas for the 70% ORS (acres), and drainage areas (acres) 
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4.2. Planning Designs 

The Python scripts were executed for the six selected HUC12 watersheds (see Figure 7) and can 

be visualized through the web platform. The design methodology could not finalize a design 

(e.g., values of D1, D2, and D3) for every ORS identified by the statewide GIS analyses. This 

outcome was expected, since the GIS analyses did not include hydrologic considerations (e.g., 

design storms, time of concentration, runoff generation mechanisms) but rather served as a 

preliminary prioritization approach. In simple terms, the GIS analyses identified good candidate 

locations for ORS implementation, and the hydrologic analysis involved in the planning design 

methodology identified the best locations among these candidates. Figure 13 summarizes the 

information generated by the planning design scripts for a selected ORS in Mill Creek. This 

figure shows the structure location, expected pool, and corresponding drainage area identified 

through the statewide GIS analyses. Additionally, it presents the values for D1, D2, and D3 

calculated using the planning design methodology, as well as the inflow and outflow 

hydrographs for the 500-year storm, demonstrating an approximate peak flow reduction of 20%. 

 

Figure 13. Example of the information generated by the planning design scripts 

4.3. HUC12-Scale Hydrologic Modeling 

The hydrologic simulations were based on high-resolution computational grids that enable the 

accurate identification of streams, watershed boundaries, and roads. The smallest computational 

elements cover an area of approximately a quarter of an acre, with larger elements away from the 

stream channel approaching five acres in size. This high spatial resolution was crucial to capture 

the effect of the ORS on the hydrologic response of the HUC12s to heavy precipitation events.  
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Each computational surface element was assigned spatially variable land use and topographic 

information that relates the location to overland roughness and land surface slopes. The National 

Land Cover Database, 2-meter DEMs, and the Soil Survey Geographic Database (SSURGO) 

were used to describe the properties of both the saturated and unsaturated regions. Models were 

forced with 50-year design storms generated using data from the NOAA Atlas 14 and the SCS 

Type II rainfall distributions. All of the simulations were run for nine days (216 hours), and the 

design storm was applied during the fourth day. ORS were incorporated using stage-storage-

discharge relationships.  

For each of the six selected HUC12 watersheds (Figure 7), Figures 14 through 25 provide 

information on various aspects. These include the dominant land cover, the computational mesh, 

the selected ORS for the simulations, and a comparison of flow peaks predicted by GHOST and 

estimated from StreamStats for 10-year, 50-year, and 100-year return periods. Additionally, two 

hydrographs are presented for each watershed that show the GHOST model outputs at the 

watershed outlet during the 50-year storm. The hydrographs illustrate both the baseline 

conditions (without ORS) and the model predictions after implementing the selected ORS. By 

analyzing the differences in hydrograph peaks, the flood reduction benefits of the chosen ORS at 

the HUC12 scale can be quantified. 

4.3.1. North Bear Creek 

 

Figure 14. Dominant land uses in the North Bear Creek watershed (left) and computational 

mesh and drainage areas contributing to the evaluated ORS (right) 
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Figure 15. Peak flow comparison at the North Bear Creek watershed outlet, showing 

modeled values (vertical axis) versus estimates from regionalization and regression 

equations (StreamStats) (left), and hydrographs at the watershed outlet depicting model 

predictions for the 50-year storm with ORS and without ORS (baseline) in place (right) 

4.3.2. Bear Creek – Soap Creek 

 

Figure 16. Dominant land uses in the Bear Creek – Soap Creek watershed (left)  and 

computational mesh and drainage areas contributing to the evaluated ORS (right) 
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Figure 17. Peak flow comparison at the Bear Creek – Soap Creek watershed outlet, 

showing modeled values (vertical axis) versus estimates from regionalization and regression 

equations (StreamStats) (left), and hydrographs at the watershed outlet depicting model 

predictions for the 50-year storm with ORS and without ORS (baseline) in place (right) 

4.3.3. Middle Branch Boone River 

 

Figure 18. Dominant land uses in the Middle Branch Boone River watershed (left) and 

computational mesh and drainage areas contributing to the evaluated ORS (right) 
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Figure 19. Peak flow comparison at the Middle Branch Boone River watershed outlet, 

showing modeled values (vertical axis) versus estimates from regionalization and regression 

equations (StreamStats) (left), and hydrographs at the watershed outlet depicting model 

predictions for the 50-year storm with ORS and without ORS (baseline) in place (right) 

4.3.4. Village of Van Horne – Prairie Creek 

 

Figure 20. Dominant land uses in the Village of Van Horne – Prairie Creek watershed (left) 

and computational mesh and drainage areas contributing to the evaluated ORS (right) 
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Figure 21. Peak flow comparison at an interior point in the Village of Van Horne – Prairie 

Creek watershed, showing modeled values (vertical axis) versus estimates from 

regionalization and regression equations (StreamStats) (left), and hydrographs at the 

watershed outlet depicting model predictions for the 50-year storm with ORS and without 

ORS (baseline) in place (right) 

4.3.5. West Branch Mill Creek – Mill Creek 

 

Figure 22. Dominant land uses in the West Branch Mill Creek – Mill Creek watershed (left) 

and computational mesh and drainage areas contributing to the evaluated ORS (right) 
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Figure 23. Peak flow comparison at the West Branch Mill Creek – Mill Creek watershed 

outlet, showing modeled values (vertical axis) versus estimates from regionalization and 

regression equations (StreamStats) (left), and hydrographs at the watershed outlet 

depicting model predictions for the 50-year storm with ORS and without ORS (baseline) in 

place (right) 

4.3.6. Upper West Fork – West Nishnabotna River 

 

Figure 24. Dominant land uses in the Upper West Fork – West Nishnabotna River 

watershed (left) and computational mesh and drainage areas contributing to the evaluated 

ORS (right) 
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Figure 25. Peak flow comparison at the Upper West Fork – West Nishnabotna River 

watershed outlet, showing modeled values (vertical axis) versus estimates from 

regionalization and regression equations (StreamStats) (left), and hydrographs at the 

watershed outlet depicting model predictions for the 50-year storm with ORS and without 

ORS (baseline) in place (right) 

Table 4 and Figure 26 present a summary of the HUC12-scale hydrologic simulations. On 

average, the evaluated ORS systems provided an 18% peak flow reduction at the watersheds’ 

outlets. It is important to note that only a subset of the ORS identified through the statewide GIS 

analyses was tested with the hydrologic models. Therefore, there is potential for greater peak 

flow reduction if more structures are evaluated. However, an important conclusion from the 

modeling results indicates that guiding conservation or watershed planning efforts based on the 

number of ORS may not be advisable. Figure 26 (left) shows that a larger number of ORS does 

not necessarily correlate with additional peak flow reductions. The results suggest that a metric 

better correlated with peak flow reduction is the percentage of the watershed regulated by the 

ORS, as shown in Figure 26 (right).  
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Table 4. Summary of the HUC12-scale hydrologic modeling 

 Peak Flows, 50-Year Storm 

HUC12 Name 

Area 

(acres) 

Number 

of ORS 

DA 

(acres) 

Regulated 

Area (%) 

Baseline 

(cfs) 

ORS 

(cfs) 

Reduction 

(%) 

North Bear Creek 20,335 53 5,282 26.0 8,304.6 6,942.9 16.4 

Bear Creek – Soap Creek 10,044 19 2,020 20.1 5,994.7 5,140.0 14.3 

Middle Branch Boone River 21,706 29 5,788 26.7 2,261.9 1,834.2 18.9 

Village of Van Horne – 

Prairie Creek 
22,333 41 7,945 35.6 12,825.2 9,796.3 23.6 

West Branch Mill Creek – 

Mill Creek 
19,857 45 7,684 38.7 7,127.0 5,842.8 18.0 

Upper West Fork West 

Nishnabotna River 
25,642 71 8,118 31.7 6,729.2 5,682.1 15.6 

DA represents the accumulated area contributing to the ORS. 

Peak flows were extracted from the hydrographs presented in Figures 15, 17, 19, 21, 23, and 25. 

 

Figure 26. Number of ORS versus peak flow reduction (left) and percent of the watershed 

regulated versus peak flow reduction (right) 

Furthermore, it is important to note that the peak flow reductions presented in the analyses were 

estimated at the watershed outlet. Significantly higher peak flow reductions (e.g., >25%) exist in 

some of the tributaries, particularly immediately downstream of the ORS. This suggests that if 

county engineers identify a culvert or bridge repeatedly impacted by flood events and receiving 

water from a relatively small area, a system of ORS upstream from the impacted area can 

provide significant flow reduction and potentially lessen the frequency and magnitude of 

infrastructure damages. 

4.4. Web Platform 

The IDOT-ORS platform combines visual and data analytics to provide a desktop-like 

environment for managing, visualizing, and analyzing large volumes of geospatial data through 

web-based mapping and visualization features (Figure 27). By using web service application 

programming interfaces (APIs), the platform ensures interoperability across various information 

systems. A client tool for these web services guarantees consistent data access. These web 
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services are unified to serve model data consistently, allowing end users to access data through a 

standardized API, regardless of their system. 

 

 
https://hydroinformatics.uiowa.edu/lab/idot-ors/ 

Figure 27. Planning designs (top) and inflow and outflow hydrographs for the 100-year 

storm (bottom) 

The platform stores the geospatial layers developed during the statewide GIS analyses and 

planning design efforts described above. The layers are visualized using the Google Maps API, 

delivering data and spatial layers in formats like KML, geoJSON, or other international 

standards from the Open Geospatial Consortium (OGC). To simplify access, a client library of 

tools that enable users to interact with IDOT-ORS web services was developed. This highlights 

the interoperability of systems adhering to consistent data and API specifications. Additionally, 

new visualization and communication tools were created using JavaScript and Canvas. Figure 27 

illustrates the information accessible via the IDOT-ORS platform. At the top are results from 

planning designs for a selected structure, while at the bottom are inflow and outflow hydrographs 

for the 100-year storm.  

https://hydroinformatics.uiowa.edu/lab/idot-ors/
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5. CONCLUSIONS AND FUTURE WORK 

The primary goal of the current research was to develop tools to guide, facilitate, and enhance 

the adoption of ORS in Iowa. This project examined various aspects of ORS, which are modified 

culverts that use road embankments as temporary dams to store water and reduce flood impacts. 

Statewide GIS analyses identified approximately 250,000 potential ORS implementation sites. 

The geospatial datasets created in this project are a valuable resource for anyone considering 

ORS implementation in Iowa. These datasets provide information on ORS locations, expected 

pool areas, and the drainage areas associated with the structures, offering a comprehensive 

foundation for planning and decision-making. 

Additionally, a methodology and Python scripts were developed to automate the hydrologic 

design of individual ORS, improving the identification of ORS that offer significant peak flow 

reduction benefits. This project also quantified the peak flow reduction benefits at the HUC12 

watershed scale for ORS systems, revealing that for a 50-year storm event, peak flows at 

watershed outlets were reduced by approximately 18%. Our modeling results suggest that the 

area regulated by ORS is a more effective parameter than the number of ORS alone for 

estimating peak flow reductions at larger spatial scales. 

Lastly, the research outcomes are accessible and can be visualized through a web platform 

integrated with Google Maps. This platform facilitates the dissemination of results and allows 

various stakeholders to understand the potential of ORS in mitigating flood impacts effectively. 

Several additional analyses can be built upon the findings and products of this research, 

including the following: 

• Expansion of planning designs. Extend the planning design scripts beyond the initial six 

selected HUC12 watersheds to cover all (approximately 1,600) HUC12 watersheds in Iowa. 

This broader analysis will enhance the selection of ORS that can provide optimal peak flow 

reduction benefits. The outcomes can be integrated into the IDOT-ORS platform. 

• Hybrid modeling approach. Introduce a hybrid approach combining the process-based 

hydrologic modeling used in this project with machine learning techniques. This approach 

can efficiently assess a larger number of HUC12 watersheds across various hydrologic 

scenarios and implementation levels of ORS, enhancing both accuracy and computational 

efficiency. 

• Alignment with the POWAR concept. Coordinate additional research efforts with ongoing 

flood resiliency planning initiatives in Iowa, such as the POtential of using a Watershed 

Approach for Reducing floods (POWAR) concept developed by the Iowa Department of 

Homeland Security and Emergency Management. This concept focuses on mitigating flood 

damages through constructed storage (e.g., ORS) upstream of vulnerable communities. 

Aligning additional research on ORS with the POWAR concept can guide mitigation 

investments effectively. 

• Economic analysis of ORS. Conduct economic analyses once the flood reduction benefits of 

ORS are quantified, and perform loss-avoidance or benefit-cost analyses to provide counties 

and communities with data necessary for securing funding to enhance flood resilience. 
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• Water quality analysis. Explore the water quality aspects of ORS, particularly the impacts 

of ORS on phosphorus movement from agricultural fields to streams. ORS, by slowing down 

water flows, can enhance sediment deposition and potentially reduce the phosphorus 

quantities reaching bodies of water. Future research efforts can try to quantify these effects to 

understand their environmental benefits. 

These potential research areas broaden the scope of the initial research, addressing critical 

aspects of flood mitigation, economic feasibility, and environmental impacts related to ORS 

implementation in Iowa.  



29 

REFERENCES 

Arenas, A., D. Gilles, M. Krasowski, N. Young, and L. Weber. 2020. Des Moines River 

Upstream Mitigation Study. IIHR Technical Report No. 533. Iowa Flood Center, IIHR–

Hydroscience and Engineering, University of Iowa, Iowa City, IA. 

Ayalew, T. B., W. F. Krajewski, R. Mantilla, D. B. Wright, and S. J. Small. 2017. Effect of 

spatially distributed small dams on flood frequency: Insights from the Soap Creek 

watershed. Journal of Hydrologic Engineering, Vol. 22, No. 7. 

Chow, V. T., D. R. Maidment, and L. W. Mays. 1988. Applied Hydrology. McGraw-Hill, New 

York, NY.  

Demir, I., and W. F. Krajewski. 2013. Towards an integrated flood information system: 

centralized data access, analysis, and visualization. Environmental Modelling & 

Software, Vol. 50, pp. 77–84.  

Demir, I., E. Yildirim, Y. Sermet, and M. Ali Sit. 2018. FLOODSS: Iowa flood information 

system as a generalized flood cyberinfrastructure. International Journal of River Basin 

Management, Vol. 16, No. 3, pp. 393–400. 

IFC. 2016. Iowa Watersheds Project Phase II Report: Otter Creek Watershed Project 

Evaluation. IIHR Technical Report No. 508. Iowa Flood Center, IIHR–Hydroscience and 

Engineering, University of Iowa, Iowa City, IA. 

Politano, M., A. Arenas, and L. Weber. 2023. A process-based hydrological model for 

continuous multi-year simulations of large-scale watersheds. International Journal of 

River Basin Management. DOI: 10.1080/15715124.2023.2216937. 

Ries III, K. G., J. K. Newson, M. J. Smith, J. D. Guthrie, P. A. Steeves, T. Haluska, K. R. Kolb, 

R. F. Thompson, R. D. Santoro, and H. W. Vraga. 2017. StreamStats, Version 4. Fact 

Sheet 2017-3046. U.S. Geological Survey, Reston, VA. 

Schall, J. D. 2012. Hydraulic Design of Highway Culverts. FHWA-HIF-12-026. Federal 

Highway Administration, Washington, DC. 

USACE. 2022. SCS Curve Number Loss Model. HEC-HMS Technical Reference Manual. 

Hydrologic Engineering Center, U.S. Army Corps of Engineers. 

https://www.hec.usace.army.mil/confluence/hmsdocs/hmstrm.  

Thomas, N. W., A. Arenas Amado, K. E. Schilling, and L. J. Weber. 2016. Evaluating the 

efficacy of distributed detention structures to reduce downstream flooding under variable 

rainfall, antecedent soil, and structural storage conditions. Advances in Water Resources, 

Vol. 96, pp. 74–87. 

USDA NRCS. 2007. Chapter 16: Hydrographs. Part 630: Hydrology. National Engineering 

Handbook. U.S. Department of Agriculture Natural Resources Conservation Service, 

Washington, DC. 

Weber, L., A. Arenas, E. Anderson, S. Landsteiner, A. Weis, K. Giannini, N. Young, D. Gilles. 

Iowa. 2023a. Iowa Watershed Approach Phase II: Middle Cedar Watershed Project 

Evaluation. IIHR Technical Report No. 536. IIHR–Hydroscience and Engineering, 

University of Iowa, Iowa City, IA. https://iowawatershedapproach.org/wp-

content/uploads/2023/03/MiddleCedar_Phase2-Project-Evaluation-Report.pdf.  

https://www.hec.usace.army.mil/confluence/hmsdocs/hmstrm
https://iowawatershedapproach.org/wp-content/uploads/2023/03/MiddleCedar_Phase2-Project-Evaluation-Report.pdf
https://iowawatershedapproach.org/wp-content/uploads/2023/03/MiddleCedar_Phase2-Project-Evaluation-Report.pdf


30 

Weber, L., A. Arenas, E. Anderson, S. Landsteiner, A. Weis, K. Giannini, D. Gilles, N. Young. 

2023b. Iowa Watershed Approach Phase II: Upper Iowa River Watershed Project 

Evaluation. IIHR–Hydroscience and Engineering, University of Iowa, Iowa City, IA. 

https://iowawatershedapproach.org/wp-content/uploads/2023/03/UpperIowa_Phase2-

Project-Evaluation-Report_Draft.docx.pdf. 

Weber, L. J., Marian Muste, A. A. Bradley, A. Arenas Amado, I. Demir, C. W. Drake, W. F. 

Krajewski, T. J. Loeser, M. Politano, B. R. Shea, and N. Thomas. 2018. The Iowa 

Watersheds Project: Iowa’s prototype for engaging communities and professionals in 

watershed hazard mitigation. International Journal of River Basin Management, Vol. 16, 

No. 3, pp. 315–328. 

Xu, H., I. Demir, C. Koylu, and M. Muste. 2019. A web-based geovisual analytics platform for 

identifying potential contributors to culvert sedimentation. Science of the Total 

Environment, Vol. 692, pp. 806–817.  

Young, N., L. Weber, D. Gilles, A. Arenas, E. Anderson, S. Landsteiner, A. Weis, K. Giannini. 

2023. Iowa Watershed Approach Phase II: North Raccoon Watershed Project 

Evaluation. IIHR Technical Report No. 537. IIHR–Hydroscience and Engineering, 

University of Iowa, Iowa City, IA. https://iowawatershedapproach.org/wp-

content/uploads/2023/03/NorthRaccoon_Phase2-Project-Evaluation-Report.pdf.  

https://iowawatershedapproach.org/wp-content/uploads/2023/03/UpperIowa_Phase2-Project-Evaluation-Report_Draft.docx.pdf
https://iowawatershedapproach.org/wp-content/uploads/2023/03/UpperIowa_Phase2-Project-Evaluation-Report_Draft.docx.pdf
https://iowawatershedapproach.org/wp-content/uploads/2023/03/NorthRaccoon_Phase2-Project-Evaluation-Report.pdf
https://iowawatershedapproach.org/wp-content/uploads/2023/03/NorthRaccoon_Phase2-Project-Evaluation-Report.pdf




THE INSTITUTE FOR TRANSPORTATION IS THE FOCAL POINT FOR TRANSPORTATION  
AT IOWA STATE UNIVERSITY.

InTrans centers and programs perform transportation research and provide technology transfer services for 
government agencies and private companies;

InTrans contributes to Iowa State University and the College of Engineering’s educational programs for 
transportation students and provides K–12 outreach; and

InTrans conducts local, regional, and national transportation services and continuing education programs.

Visit InTrans.iastate.edu for color pdfs of this and other research reports.


	flood_reduction_benefits_of_on-road_structures_CLEAN.pdf
	Acknowledgments
	Executive Summary
	1. Problem Statement and Objectives
	2. Background Information
	2.1. Flooding in Iowa
	2.2. Examples of On-Road Structures in Iowa
	2.3. Distributed Storage and Hydrologic Modeling
	2.4. Web-Based Information Systems

	3. Methodology
	3.1. Statewide GIS Analyses
	3.2. Planning Designs
	3.2.1. Script 1
	3.2.2. Script 2
	3.2.3. Script 3

	3.3. HUC12-Scale Hydrologic Modeling
	3.4. Web Platform

	4. Results
	4.1. Statewide GIS Analyses
	4.2. Planning Designs
	4.3. HUC12-Scale Hydrologic Modeling
	4.3.1. North Bear Creek
	4.3.2. Bear Creek – Soap Creek
	4.3.3. Middle Branch Boone River
	4.3.4. Village of Van Horne – Prairie Creek
	4.3.5. West Branch Mill Creek – Mill Creek
	4.3.6. Upper West Fork – West Nishnabotna River

	4.4. Web Platform

	5. Conclusions and Future Work
	References

	InTrans_report_inside_outside_back_cvr.pdf
	Blank Page





Accessibility Report





		Filename: 

		Assessing the Flood Reduction_202407_REM.pdf









		Report created by: 

		



		Organization: 

		







[Enter personal and organization information through the Preferences > Identity dialog.]



Summary



The checker found problems which may prevent the document from being fully accessible.





		Needs manual check: 2



		Passed manually: 0



		Failed manually: 0



		Skipped: 1



		Passed: 27



		Failed: 2







Detailed Report





		Document





		Rule Name		Status		Description



		Accessibility permission flag		Passed		Accessibility permission flag must be set



		Image-only PDF		Passed		Document is not image-only PDF



		Tagged PDF		Passed		Document is tagged PDF



		Logical Reading Order		Needs manual check		Document structure provides a logical reading order



		Primary language		Passed		Text language is specified



		Title		Passed		Document title is showing in title bar



		Bookmarks		Passed		Bookmarks are present in large documents



		Color contrast		Needs manual check		Document has appropriate color contrast



		Page Content





		Rule Name		Status		Description



		Tagged content		Passed		All page content is tagged



		Tagged annotations		Passed		All annotations are tagged



		Tab order		Passed		Tab order is consistent with structure order



		Character encoding		Passed		Reliable character encoding is provided



		Tagged multimedia		Passed		All multimedia objects are tagged



		Screen flicker		Passed		Page will not cause screen flicker



		Scripts		Passed		No inaccessible scripts



		Timed responses		Passed		Page does not require timed responses



		Navigation links		Passed		Navigation links are not repetitive



		Forms





		Rule Name		Status		Description



		Tagged form fields		Passed		All form fields are tagged



		Field descriptions		Passed		All form fields have description



		Alternate Text





		Rule Name		Status		Description



		Figures alternate text		Failed		Figures require alternate text



		Nested alternate text		Passed		Alternate text that will never be read



		Associated with content		Passed		Alternate text must be associated with some content



		Hides annotation		Passed		Alternate text should not hide annotation



		Other elements alternate text		Passed		Other elements that require alternate text



		Tables





		Rule Name		Status		Description



		Rows		Passed		TR must be a child of Table, THead, TBody, or TFoot



		TH and TD		Passed		TH and TD must be children of TR



		Headers		Failed		Tables should have headers



		Regularity		Passed		Tables must contain the same number of columns in each row and rows in each column



		Summary		Skipped		Tables must have a summary



		Lists





		Rule Name		Status		Description



		List items		Passed		LI must be a child of L



		Lbl and LBody		Passed		Lbl and LBody must be children of LI



		Headings





		Rule Name		Status		Description



		Appropriate nesting		Passed		Appropriate nesting










Back to Top



